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USER NOTICE
Announce
This user manual includes special documents, which is under protection of cop-
yright law. All rights reserved. Without written announcement from our company, 
the contents in this manual should not be transferred, copied or translated into 
other language.
Owing to the forthcoming renovation or error contained in the manual, the specific 
products you received may not be totally in accordance with the description of 
this User Manual. We would sincerely regret for that.
Our company reserves the final elucidative right.

Manufacture’s Responsibility
Our company is responsible for safety, reliability and performance of this product 
only in the condition that: all installing and repairs of this product are conducted 
by our company’s authorized personnel; and this product is operated under strict 
observance of this manual.

 Warning: This device is not intended for treatment. If the result is dis-
trustful, please use other methods to verify immediately.

Warranty
The unit can not be repaired by users themselves. All services must be done by 
the engineers approved by manufacturer. We warrant that each product we sell 
you is free from defects in labour and materials and shall conform to its product 
specifications as defined in the user documentation. If the product doesn’t func-
tion as warranted during the warranty period, we will repair or replace it for free 
charge. Misuse, improper maintenance may void from the warranty.

Explanation of label in the manual

 Warning: the information that should be noted to avoid injury to the patient 
and the operator.

 Attention: important information that you should know.

• Item: item message.
 

ENGLISH
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1 Safety
1.1 Safety Instructions 
• Test at regular period to verify there is not evident damage that may affect
 safety and monitor performance. The period is recommended to be less than 

one month. If there is any damage, stop using it immediately.
• The maintenance of the device should only be carried out by personnel au-

thorized and specified by our company, and the user shall not maintain it by 
himself.

• The device should not be used with other devices that not specified in this 
manual. Especially for those accessories specified or recommended by manu-
facture.

• The device has been calibrated before leaving factory.

1.2 Warnings
 The infrared is harmful to the eyes, so the user and the maintenance man 

should not stare at the light part of the SpO2 probe (the infrared is invisible).
 For the special patients, there should be a more prudent inspecting in the 

placing process. The SpO2 probe can not be clipped on the edema and ten-
der tissue.

 Please don’t use this device when charging.
 Explosive hazard—DO NOT use the device in environment with inflammable 

gas such as some ignitable anesthetic.
 DO NOT use the device while the patient is being scanned by MRI or CT.
 Protect the wrist band for normal use; and wear it tightly to avoid dropping 

to broken in the operation; the user who is allergic to rubber shall not use the 
wrist band.

 Please use the accessories and probe that the manufacture specifies or rec-
ommends to avoid damage to this device.

 The disposal of scrap instrument and its accessories and packings (including 
battery, plastic bags, foams and paper boxes) should follow the local laws 
and regulations.

 Please do not test the related information of this device with function tester.
 Do not transport this device with poisonous, deleterious or mordant sub-

stances.
 No modification of this equipment is allowed.
 When the equipment was used in home, patients might be expected, 

and the patient should pay attention to the specifications of 1.2 on the 
operator’s warning and note 1.3 

ENGLISH
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 The equipment is prohibit from repairing or vindicating during it is using. 
 Moreover, the external computer, CD or Type with recording cable which con-

nected with the Sleep apnea screen meter must be certificated according to 
the relevant IEC standards (such as: IEC 60601-1). For the requirements that 
are applicable to an ME SYSTEM, the RESPONSIBLE ORGANIZATION shall 
be referred to this standard.

1.3 Attention

 Please check the packing before use to make sure the device and acces-
sories are totally in accordance with the packing list, or else the device may 
have the possibility of working abnormally.

 The device may be a little different from the picture of manual, please make 
the actual device as standard.

 Keep a operation environment without dust, vibration, flammable or mordant 
substances.

 When moved from a place cold to another warm and wet one, do not use it 
at once.

 Do not operate the buttons with sharp tools.
 Do not disinfect this device with high temperature and pressure or gas.
 Do not immerse this device in liquid. When cleaning its surface with medical 

alcohol, do not spoil it directly on the device.
 This device has prompt sound function, if it is not necessary, you can choose 

to silence it.
 The mode of operation for this device is continuous, and it is common equip-

ment, if splashed and coagulated, stop operation.
 The service life of this device is five years.
 At the end of this device’s service life, return it to your manufacture for circle 

use or dispose it in compliance with local regulations.
 Please refer to respective chapter for more notes.

ENGLISH



6

2 Brief Introduction
2.1 Overview
The device is applied for the persons who have Sleep apnea-hypopnea syndrome 
(SAHS). It can be used in hospital and home.
The device’s SpO2 is based on anti-movement-interference design, applied for 
routine sports and exercise, displayed with LCD, monitors real-time SpO2, pulse 
rate and nose air flow, and also with setupable alarm function.
Human power on/off design: manual and time power on/off two modes. 
The patient can either adopt manual power on/off mode to store or set up time 
power on/off, having estimated his sleep time, which can decrease patient’s men-
tal burden and make patient take monitor easy. After time power on, the device 
will save cases automatically.
The device has large capacity SD card, which can save multiply cases, and up-
loads or directly stores cases to PC though USB data line. The strong PC software 
can edit personal information for case long storage, analyze cases gathered to 
help doctor diagnose quickly, and will be to the requirements of such aspects as 
respiration, clinical, E.N.T. departments and sleep center, etc.
The patient can also invite expert to diagnose remotely via network, which helps 
patient with physical examination at home.

2.2 Main Functions and Features
• LCD display screen
• Convenient operation
• Wrist-design,tiny and light
• Multiple functions in one device,supplying more vital information
• SpO2 and pulse rate(hereinafter referred to as “PR”) value display
• Pulse sound and indicator bar
• Pulse and nose flow waveform display
• Such alarms as low power, finger out and exceeding limits can be set up
• Real-time clock
• Auto-power on/off 
• Multi-case record
• Continuous 12 hours data record
• Uploading Data via USB port
• Powerful PC analysis software 

ENGLISH
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2.3 Accompanying Accessories 
• A power adaptor
• An USB data line
• Two kinds of SpO2 probes
• A Nasal cannula
• A CD (PC software)
• An user manual
 

3 External Appearance and Structure  

3.1 Buttons and Connections

 : Power on / Power off  /Awake button

 : Menu / Confirm button

 : Nasal cannula connection

 : Charge / SpO2 probe / USB connection

Operation / Carge 
indicator light

Power on / Power off / 
Awake button

Menu / Confirm button

Nasal cannula 
connection

Charge / Oximeter 
probe / USB connection

ENGLISH
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3.2 Instructions for Front Panel 
The measurement interface is showed as Figure3-2-1.
 

Figure 3-2-1 measurement interface

The record interface is showed as Figure3-2-2.

Figure3-2-2 record interface

(1) SpO2 value display
 Indicator: %SpO2

 Instruction: Put the finger into the SpO2 probe,and the corresponding SpO2

 value will be displayed here.

ENGLISH
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(2) Pulse rate value display
 Indicator: PRbpm
 Instruction: Put the finger into the SpO2 probe,and the corresponding pulse
 rate value will be displayed here.
(3) Bar graph display
 

 Indicator: 
 
 Instruction: Put the finger into the SpO2 probe, and pulse beat will be displayed 
here.
(4) Nose air flow display
 Indicator: FLOW
 Instruction: Real-time display nose air flow waveform.
(5) SpO2 plethysmogram waveform display
 Indicator: SpO2

 Instruction: Real-time display SpO2 plethysmogram waveform.
(6) Pulse sound indicator
 Indicator:    
 Instruction: The former indicates pulse sound is on, while the later indicates   
 it is off.
(7) Prompt sound indicator
 Indicator:     
 Instruction: The former indicates prompt sound is on, while the later indicates 
 it is off.
(8) Battery capacity indicator
 Indicator:  
 Instruction: It indicates battery capacity, it indicates that the power is low when
  appears and flickers.
(9) Time display
 Indicator: 08:55
 Instruction: Here it indicates real-time clock.
(10) Record indicator
 Indicator: REC •
 Instruction: • flash indicates it is saving data.
(11) Recorded time display
 Indicator: Recorded time: 00:00:01
 Instruction: The device is recording the record time (hour:minute:second).
(12) SpO2 alarm low limit value display
 Indicator: 85
 Instruction: SpO2 alarm low limit value.

ENGLISH
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4 Device Operation Explanation
4.1 Button Operation
Power on / Power off / Awake button: 
Powering on operation: Long press the button , then the green indicator light 
is on, LOGO is displayed and enter the measurement interface.
Powering off operation: Long press the button  without recording, the screen 
displays “Bye-Bye!”, and then the work indicator light is off.
Screen awaking operation: In recording status, if there is no button operation for 
60 seconds,the screen will be shut up automatically to enter power-saving status. 
Short press the button  to awake the LCD to display.

Menu / Confirm button: 
In measurement interface,long press button “M” to enter the main menu.
You can look through the menu by short pressing button “M”,and access the 
submenu or set up the selected item by long pressing.

4.2 Menu Operation
4.2.1 Main Menu
In measurement interface, long press button “M” to enter the main menu, as Fig-
ure 4-2-1.
 

Figure 4-2-1 Main menu

ENGLISH

Callout Function Instruction

1 Alarm Alarm setup,long press “M” button to access 
alarm setup menu.

2 System Setup Long press “M” button to access system setup 
menu.

3 Schedule 
Power on

Auto poweron Setup, long press “M” button to 
access Auto poweron Setup menu.
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Table 4-2-1

4.2.2 Alarm Setup
Alarm setup menu is showed as Figure 4-2-2.
 

Figure 4-2-2 Alarm setup menu

Table 4-2-2

ENGLISH

4 Record Record setup, long press “M” button to access 
record setup menu.

5 DEMO Long press “M” button to enter DEMO interface.

6 Clock Time setup, long press “M” button to access 
time setup menu.

7 Exit Exit to the measurement interface.

Callout Function Instruction

1 SpO2 ALM HI SpO2 alarm high limit, setup range is 1~100, 
default is 99(unit:%).

2 SpO2 ALM LO SpO2 alarm low limit, setup range is 0~99, 
default is 85(unit:%).

3 PR ALM HI Pulse rate alarm high limit, setup range is 
1~254, default is 150 (unit:bpm).

4 PR ALM LO Pulse rate alarm low limit,setup range is 0~253, 
default is 50 (unit:bpm).

5 Alarm Alarm setup, ON or OFF can be selectable, 
default is OFF.

6 Pulse Sound Pulse sound setup, ON or OFF can be 
selectable, default is OFF.

7 Exit Exit to the upper-level menu.
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With alarm function on, when measurement value exceeds limit, the device gives 
audio prompt. With pulse sound on, it will give pulse prompt.

4.2.3 System Setup
System setup menu is showed as Figure 4-2-3.
 

 Figure 4-2-3 System setup menu

Table 4-2-3

4.2.4 Auto poweron Setup
Auto poweron Setup menu is showed as Figure 4-2-4.
 

 Figure 4-2-4 Time powering on setup menu

ENGLISH

Callout Function Instruction

1 Hard.ver Hardware version number, user can not set up.

2 Soft.ver Software version number, user can not set up.

3 PCsoft.ver PC software version number, user can not set up.

4 Time format 24-hour format,user can not set up.

5 Language User can switch languages between English and 
Chinese.

6 Exit Exit to the upper-level menu.
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Table 4-2-4

Note: You shall not set up time powering on when the device is in record status.

4.2.5 Record Setup
1) Not in record status,the record setup menu is showed as Figure 4-2-5-1.
 It prompts whether to begin record or not. Select YES to exit, it access the 

record interface (as Figure 4-2-5-2) to save and the record indicator REC dot 
flashes, the “Recorded Times” records the recorded time. 

 Select NO to exit, it will not record.
 

 Figure 4-2-5-1 Starting record menu
 

 Figure 4-2-5-2 Record interface

ENGLISH

Callout Function Instruction

1 Set Month Month setup, 1~12 can be selected.

2 Set Day Day setup, 1~31 can be selected.

3 Set Hour Hour setup, 0~23 can be selected.

4 Set Minute Minute setup, 0~59 can be selected.

5 Record Record duration setup, 1~10 can be selected 
and default is 8, unit:hour.

6 Are you sure? Confirming information, NO/YES can be selected, 
YES: confirm   NO: cancel

7 Exit Exit to the upper-level menu. When exit in YES 
status, the setup you have done takes effect.
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Note: 
 In record status, the interface prompts “TF Card is full!”, it indicates the remain-
ing capacity of SD card is lack and the user shall not do record operation. And the 
user needs to displace previous cases by computer.
Manual power off can not be performed in record status, please stop recording 
before power off.

Suggestion: 
Termly copy the cases to the computer in case of losing the cases when the 
SD card is damaged. Do not store any file except the cases.

2) In record status,the record setup menu is showed as Figure 4-2-5-3.
 It prompts whether to stop record or not, select YES to exit,stop record. Select 

NO to exit, it will still record.
 

 Figure 4-2-5-3 Stop record menu

4.2.6 Demo Interface
Demo interface is showed as Figure 4-2-6,and in DEMO mode prompt sound and 
pulse sound are off, it can not be switched on, Long press “M” to exit.
 

 Figure 4-2-6 Demo interface

ENGLISH
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4.2.7 Time Setup
Time setup menu is showed as Figure 4-2-7.
 

 Figure 4-2-7 Time setup menu

Table 4-2-7

Note: You shall not set up time when the device is in record status.

4.3 Sensor Connection
4.3.1 Nose Air Flow Monitoring
Unpack the Nasal cannula,wrest down the screw cap following Figure 4-3-1-1, 
then insert the Nasal cannula in its upper-right jack and screw down. 
Insert the tie-in in sleep apnea screen meter, and the oxygen-absorbing apparatus 
in the nose, with oxygen-dividing connection tube round between the nose and 
chin. Adapt orientation circle to a comfortable position, then power on, and after 
serval seconds, the waveform is stable and you can examine respiration status.

ENGLISH

Callout Function Instruction

1 Set Year Year setup, 2010~2099 can be selected.

2 Set Month Month setup, 1~12 can be selected.

3 Set Day Day setup, 1~31 can be selected.

4 Set Hour Hour setup, 0~23 can be selected.

5 Set Minute Minute setup, 0~59 can be selected.

6 Are you sure? Confirming information, NO/YES can be selected, 
YES: confirm  NO: cancel

7 Exit Exit to the upper-level menu. When exit in YES 
status, the setup you have done takes effect, at the 
same time display the effected time.
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The method of wearing the Nasal cannula is as showed in Figure 4-3-1-2, and that 
of the entire sensor wearing is as Figure 4-3-1-3.

  

Figure 4-3-1-1 Interface icon
 

Figure 4-3-1-2 Wearing Nasal cannula

Correct

Wrong

ENGLISH
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Figure 4-3-1-3 The entire wearing of sensor

Note: 
 Wear the Nasal cannula according to the regulations, or it will affect the gath-
ering effect.

4.3.2 SpO2 and Pulse Rate Monitoring
The scheme of the following three probe could be chose by user, as table 4-3-2.

Table 4-3-2

Figure 4-3-2-1 One-off adhesive SpO2 probe Figure 4-3-2-2 Adult fingertip SpO2 probe

ENGLISH

Appellation Quantity Scheme

One-off adhesive SpO2 probe 2 Standard (Figure 4-3-2-1) 

Adult fingertip SpO2 probe 1 Standard (Figure 4-3-2-2)

Binding SpO2 probe 1 Optional (Figure 4-3-2-3)
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 Figure 4-3-2-3 Binding SpO2 probe
 

 Figure 4-3-2-4 Placing SpO2 probe

Plug the SpO2 probe into USB interface, as Figure 4-3-2-4.
1) Connect the probe with the device.
2) Put the finger into the probe.
3) In measurement interface,you can directly read corresponding data from dis-

play screen.

 Warning: Use the SpO2 probe specified by our company,and other SpO2 
probes are forbidden.

Notes: 
 Testee’s fingernail shall not too long.
 Testee shall not use enamel or other makeup.
 The finger too cold or too thin may affect the measurement; when measuring, 

please insert the thicker finger fully into the probe (thumb or middle finger rec-
ommended).

 In operation, the finger tested shall not tingle and the testee shall not be in 
movement.

 When inserting the finger, fingernail and the luminescent tube should be on the 
same side

ENGLISH
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 Excessive ambient light may affect the measuring result,including fluorescent 
lamp, dual ruby light, infrared heater, direct sunlight and etc.

 There should not be such light barrier as rubber fabric on the way of light, or it 
may result in incorrect measure results of SpO2 and pulse rate.

 The SpO2 probe and photoelectric receiving tube should be arranged in a way 
with the testee’s arteriole in a position there between.

 The SpO2 sensor should not be used at a location or limb tied with arterial 
canal or blood pressure cuff or receiving intravenous injection.

 Acute testee movement or electrosurgical interference can affect the accuracy.
 Data update period is less than 5 seconds, which is changeable according to 

different individual pulse rate.
 Please read the measured value when the waveform on screen is equable and 

steady-going, of which the value is optimal. And the waveform at the moment 
is the standard one.

 The problem of overrating would display when the patient is suffering from 
toxicosis which caused by carbon monoxide, the device is not recommended 
to be used under this circumstance.

 The finger shall be put correctly (refer to the related Figure 4-3-2 in the manual) 
or the measurement results may be incorrect.

4.4 Clinical Restrictions
SpO2

1) As the measure is taken on the basis of arteriole pulse, substantial pulsating 
blood flow of subject is required. For a subject with weak pulse due to shock, 
low ambient/body temperature, major bleeding, or use of vascular contracting 
drug, the SpO2 waveform (PLETH) will decrease. In this case, the measure-
ment will be more sensitive to interference.

2) For those with a substantial amount of staining dilution drug (such as methyl-
ene blue, indigo green and acid indigo blue), or carbon monoxide hemoglobin 
(COHb), or methionine (Me+Hb) or thiosalicylic hemoglobin, and some with 
icterus problem, the SpO2 determination by this monitor may be inaccurate.

3) The drugs like dopamine, procaine, prilocaine, lidocaine and butacaine may 
also be a major factor blamed for serious error of SpO2 measure.

4) As the SpO2 value serves as a reference value for judgement of anemic anoxia 
and toxic anoxia, some patients with serious anemia may also report good 
SpO2 measurement.

 Warning: Please refer to corresponding medical literature for details about 
clinical limits and tabu illness.
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Nasal cannula
 Warning: Shock,conk patient shall be monitored directed by medical stuff or 

professional paramedics.

4.5 Time Powering on Function
(Refer to 4.2.4 Time powering on setup) 
After having set up the time for powering on,you can power off, and when the 
clock arrives to the time set,the device will power on automatically and save. After 
the set duration operation,the device will power off automatically.

4.6 USB Data Uploading
Long press   key to power on and access the main interface, plug one port of 
the USB data line into USB connection as Figure 4-6-1, the other into PC’s “USB” 
port as Figure 4-6-2, the connection method between the device and PC is shown 
as Figure 4-6-3. then the PC begins to read SD card. 
In my computer,double-click the new disk symbol newly occurring to search for 
the record data,copy the data from SD card, and save it in any disk of my comput-
er,and open the saved file via PC software to analyse patient’s sleep information. 
(“Power on” ---- “Plug in USB data line” ---- “Open my computer” ------- “Search 
for the device disk symbol” ----- “Copy the .bin file to PC hard disk to avoid data 
missing”).

Figure 4-6-1 Connection between sleep  Figure 4-6-2 Connection between
apnea screen meter and USB data line PC and USB data line
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Figure 4-6-3 Connection between PC and the device

1. USB data line
2. The device
3. PC

Notes: 
 Data can not be uploaded during recording. To upload data, please stop re-

cording. 
 If the computer can not identify the disk symbol, connect USB data line repeat-

edly.

4.7 Charging Operation
Two methods for charging: 
1) Connect one end of the data line to PC, the other to the device, and the battery 

is then charged.
2) Connect one end of the power adapter to power receptacle, and the other to 

the device with data line.

Charging indicator light: when the battery is being charged, the light is orange; 
while the battery is full power, the light is green.

Note: 
 To ensure enough operation time,charge the battery to full power before meas-

uring.
 

ENGLISH
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5 PC Software Operation Explanation
Double click Shortcuts to enter the operation system (hereinafter referred as “this 
system”) as shown in Figure 5-1.

 
Figure 5-1

5.1 Data Importing and Case Management
1: Import Case Data
Startup this software and import data. Click “Import Case Data” in “File” menu, 
then the following Figure 5-1-1 will appears: 
 

Figure 5-1-1

Click the button “Open”, then the data importing interface appears, as Figure 
5-1-2. Find the saving path of the case, and click “Import Case”. You must firstly 
fill in the name of the patient, then click “Import Case” to enter the interface of 
waveform display as Figure 5-1-3, and the case information is saved in the case 
library. If the patient’s name is empty, this system will prompt.

ENGLISH
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 Figure 5-1-2
  

Figure 5-1-3

2. Case Management
Click “Case Manage” in “File” menu to its sub-menu as Figure 5-1-4: 
 

ENGLISH
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Figure 5-1-4

The left of the interface are all cases in the case library. When selecting any case, 
the relative patient information will display on the right of the interface, including 
patient’s basic information and gathered information, you also can add the name 
of the physician, recorder, and the marks the doctor made. 
Click “Picture Path” to choose the patient’s picture, next click “Save”, the picture 
will be displayed in the report.
This system has the functions of modifying and deleting patient’s information, if 
you want to modify some case information, first, select the patient on the left, and 
then modify the information as you like on the right, click “Save Case” to complete 
modifying patient’s information; if you want to delete some case information, first 
select it, then click “Delete Case”, the system will prompt to verify whether to 
delete or not(as Figure 5-1-5), click “OK” to delete the case forever from the case 
library. Double click the case in case management interface to enter correspond-
ing case waveform display interface (as Figure 5-1-3).

 

Figure 5-1-5
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5.2 System Setting
Select “Global Setting” in “Setting” menu, the global setting dialogue box will pop 
up as shown in Figure 5-2-1.
 

 Figure 5-2-1

1) Fill in the basic hospital information in the “Hospital Info” interface.
2) Set the waveform color or the waveform state of each lead in “Channel setting” 

interface, as shown in Figure 5-2-2: 
 

 Figure 5-2-2
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3) There are two interfaces (SpO2 and flow) in “Param Setting”, you can set up the 
parameter value in the respective interface (as Figure 5-2-3).

 

Figure 5-2-3

4) You can add, edit and delete marks in “Mark” interface, as shown in Figure 
5-2-4: 

 

Figure 5-2-4

ENGLISH
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Click “Add” to enter “Add Mark” dialogue box (as Figure 5-2-5). Click “OK”, the 
new mark will display in the mark list. If you want to edit some mark, first, select 
mark name in the mark list, click “Edit” or double click mark name, the “Edit Mark” 
dialogue box will appear (as Figure 5-2-6). (The front eight items in the mark list 
are default, they can not be deleted or edited, but their color can be modified) Se-
lect some mark and click “Delete” to delete user-defined mark. (Refer to chapter 
5.3 for details)
 

Figure 5-2-5
 

Figure 5-2-6

5) You can set up the display language through “Language” option (as Figure 5-2-
7).
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Figure 5-2-7

When clicking “OK” button in “Global Setting” dialogue box, the setup you have 
done will be saved in system setting.

5.3 Waveform Display
The waveform display area is shown in Figure 5-1-3, the display area can display 
two waveform charts, or one event chart and one waveform chart, or only event or 
waveform chart. Window adjusting button can change the amount of charts and 
size of the area, shown as Figure 5-3-1: 
 

Figure 5-3-1

Four-lead data waveform for Flow, SpO2, Pulse, Pleth will be displayed in chart 
display area, (as Figure 5-3-2). Drag the borderline of each waveform to change 
the size of display area, which is convenient for observing. Some data marks 
displayed in the front of each lead can use to confirm corresponding value, as 
Figure 5-1-3(3): 
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Figure 5-3-2

The buttons on the right of the waveform display area are showed 
in Figure 5-3-3, here, you can adjust the size and the baseline

position of the waveform. When clicking  , the amplitude will

get bigger; when clicking  , the amplitude will get smaller; 

when clicking  , the baseline will move up; when clicking

 , the baseline will move down. Meanwhile,when adjusting 
the amplitude, the data mark in Figure 5-3-2 will change corre-
spondingly, while for the leads without data mark, the waveform 
gain back of the waveform name will change bigger or smaller.
  

 Figure 5-3-3
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Drag the mouse on some waveform while 
clicking the right button and the mark dia-
logue box in Figure 5-3-4 will pop up, select 
the mark type, click “OK” to mark in corre-
sponding position (as Figure 5-1-3(2)), put the 
mouse on the borderline of the marked area, 
when the editing sign occurs, you can drag 
the mouse to adjust the marked area size. 
(New marks can not cover old ones.) 
Select some mark on the waveform and click 
“Delete” in the keyboard or clicking the right 
button to delete the mark.
 

 Figure 5-3-4

Drag the left button of the mouse, then the corresponding dialog box will appear 
(as Figure 5-3-4), “Sleep Begin” and “Sleep End” marks can be set as Figure 
5-1-3(1): 

The time axes display area is showed as Figure 5-3-5. Dragging the scroll bar or 
rolling the mouse wheel to browse the waveform. Meanwhile, press “PgUp” and 
“PgDn” to switch the waveform display between previous and next screen. Press 
“Home” and “End” to return to the start and end position of the waveform.

The time axes displays the beginning and end time of data record and set up a 
time coordinate every five seconds. When the position of the scroll bar changes, 
the time of the axes will change correspondingly.
 

Figure 5-3-5

Time selections are showed as Figure 5-3-6, you can set the time interval of a 
screen, also set different time intervals of the upper and netherchart display areas 
and synchronously view. 
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Figure 5-3-6

The buttons for browsing events are showed as Figure 5-3-7, you can select the 
event name you want to browse in the list, click the left and right arrowhead but-
tons to browse the event marks one by one, which is convenient for observing. If 
there is no suited mark event, this system will give prompt.

 

Figure 5-3-7

5.4 Function Menus
There are some function menus in the waveform display interface (as Figure 5-4-
1). 

1. Click “Import Case” in “File” menu, then the case information interface will 
appear as Figure 5-1-1, which can help doctors import the other patient’s data 
when observing one patient’s waveform.

 

 Figure 5-4-1

2. There are two menu options in the “Edit” menu: “Undo Ctrl+Z” and “Redo 
Ctrl+Y” (as Figure 5-4-2). Click the options to undo and redo the waveform 
mark.
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 Figure 5-4-2

3. There are two menu options in the “View” menu, “Report View” and “EventList 
View” (as Figure 5-4-3). “Report View” menu is used to print reports, when clicking 
this option, the print preview interface will appear as Figure 5-4-4: there are such 
functions as zooming in, zooming out and paging-up and paging-down functions, 
when all have been done, click “Print” and the case report will be printed out.

 

 Figure 5-4-3
 

Figure 5-4-4
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It also has such functions as editing the diagnosis information and filling it into 
the report, click “Diagnose” and the Diagnose info interface will appear, as Figure 
5-4-5, then you can fill in the diagnosis information and report name. Click “OK” 
to fill the report name and diagnosis information into the report.
Click “Excel Export”, the system will export the first page of report as a form of 
Excel spreadsheet to the file that user specified.

Note: The Excel export function can be applied only preinstalled with Microsoft 
Office 2003 or higher version.
 

Figure 5-4-5

4. When selecting “EventList View” option, the interface as Figure 5-4-6 will ap-
pear. event type is displayed on the left, this system are divided into four types: 
Other, SpO2, Breath and pulse. Mark name, the start and end time of mark and 
interval will be displayed on the right of the event list. 

 Click “All events”, then the mark of all events will be displayed in the right list.
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Figure 5-4-6

5. Click “Reanalyse”, the dialogue box as Figure 5-4-7 will appear, click “OK”, you 
will remove the old data and reanalyse; click “No” to reanalyse but not remove 
the manual analyse data; click “Cancel” to cancel the reanalyse operation.

 

Figure 5-4-7

6. Click “Patient info”, and the current patient information will appear which is 
convenient for the doctor to analyse the patient’s case.
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 Figure 5-4-8

7. Click “Help”, and the help document of this software will appear.

6 Product Specification
Product name: Sleep apnea screen meter
Safety: complied with the standard IEC 60601-1
Classification:
Compatibility: Group I,Type B
Power type: internal powered equipment
The degree of protection against electric shock: BF applied part.
The degree of protection against entry liquids: IP22 grade, SpO2 probe IPX1.
The degree of safety of application in the presence of flammable gas: not usable 
in the presence of flammable gas.
The mode of operation: continuous operation
Physical characteristic: 
Size: 69(L)× 50(W)×17.3 (H)mm
Weight: 100g
Environment requirements: 
(1) Transportation and record: 
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 Environment temperature range: - 40°C~+55°C 
 Relative humidity range: ≤95 % 
 Atmospheric pressure range: 500 hPa~1060 hPa
(2) Operation:
 Environment temperature range: 10°C~40°C 
 Relative humidity range: ≤75% 
 Atmospheric pressure range: 700 hPa~1060 hPa  
Battery type: 3.7V Chargeable lithium battery
Operation voltage: 3.6 V DC ~ 4.2V DC.
Operation current: :≤100 mA
Display screen: LCD display screen
Performance parameters
(1) Nose air flow measurement: 
 Measurement range: 0rpm~40rpm
 Resolution: 1rpm
 Accuracy: ±2rpm
(2) SpO2 measurement: 
 Measurement range: 0%~100%
 Resolution: 1%
 Accuracy: 70%~100%, ±2%; <70% unspecified
(3) Pulse rate measurement:
 Measurement range: 30bpm~250bpm 
 Resolution: 1bpm
 Accuracy: ±2 bpm and ±2% (selecting larger)
(4) Resistance to surrounding light:
 The deviation between the value measured in the condition of man-made light  
 or indoor natural light and that of darkroom is less than ±1%.
 

7 Cleaning, Disinfection and Maintenance
7.1 Cleaning
Keep the exterior surface of the device clean, without dust and dirt. 
The exterior surface of the device shell may be cleaned with a clean and soft 
cloth, if necessary,with soap water or dampened soft cloth, and remember to dry 
it with dry cloth at once. Nasal cannula is one-off, of which the connection may be 
cleaned with medical alcohol,then air-dry it, or with a dry cloth.

Notes:
 Power off the device before cleaning.
 Never use such acute solutions as acetone.
 Never use worn materials (like steel wire or silver polishing reagent)
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 The temperature of the device cleaning water is below 60°C.
 Never permit any liquid run into the device,nor submerge the device into any 

liquid.
 Never spoil liquid on the device when cleaning.
 Never remain any solution on the surface of the device.

7.2 Disinfection
After cleaning the device with the methods above, disinfect it with medical alco-
hol, then air-dry (or with dry cloth).

Notes:
 Never disinfect the device with the method of low temperature steam or high 

temperature.
 Never use electron shoot bind or other methods to disinfect.

7.3 Maintenance
Before using the device,check it for evident damages which may possibly affect 
patient’s safety. We recommend the check period is once a month (or shorter 
period). In case of evident damage,it is recommended to replace the damage 
parts before using.
The device is precise electrical equipment,take and put it carefully. For a longer 
service life, take the following measures to maintain the device.
1) When the battery is in low power, recharge it in time.
2) After fully discharged,the battery should be recharged as soon as possible.
 If the device is not used for long, you shall make entire charge/discharge oper-

ation every 6 months.
3) Please clean and disinfect the device before using it on patient.
4) Disinfect the device after use in case not cause cross infection in use again.
 The device determines its accuracy, which can not adjusted by user. If there 

is any doubt about the measurement result, use other methods to verify, or 
contact your local agent or manufacturer for help.

Notes:
 Maintaining this device must be carried out by our company’s authorized and 

qualified engineer.
 If not in use for long,clean, disinfect this device and save it in the packing case, 

then put it in a draughty place without caustic gas.
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8 Symbol Meanings

Symbol Meaning

Follow instructions for use

% SpO2 SpO2 value (unit: %)

PR bpm Pulse rate (unit: bpm)

Full power

Leak power

Audio prompt off

Audio prompt on

Pulse sound off

Pulse sound on

REC • Record indicator

Type BF applied part

WEEE disposal

USB data connection

0123 Medical Device complies with Directive 93/42/EEC 

1060hPa

500hPa
Atmospheric pressure limitation

55°C

-40°C Store between 10 and 40°C
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Symbol Meaning

%
95%

0%
Humidity limitation

Disposable device, do not re-use

Product code

Lot number 

Serial number

Caution: read instructions (warnings) carefully

Manufacturer

Authorized representative in the European community

Date of manufacture

Keep in a cool, dry place

Keep away from sunlight

Fragile, handle with care

IP22 Covering Protection rate
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9 Trouble Shootings

The device may not meet your intended purpose owing to operation or other prob-
lems, and consult the following troubleshooting to solve the problems you have met.

Appendix 1

ENGLISH

Trouble Possible cause Solution

SpO2 or Pulse rate is 
displayed abnormally.

1.The finger is not put in cor-
rectly.

2.Patient SpO2 value is beyond 
the measurement range.

3.The deepness of the finger 
putting in is not enough.

4.The finger wobbles or the 
patient is in movement.

1.Try again with the finger 
correctly put in.

2.Try repeatedly,if you are 
sure the product perfor-
mance is normal,go to 
hospital for diagnose.

3.Try again with the finger 
correctly putting in.

4.Please keep calm.

Nose air flow waveform 
display is instable.

1.Connection problem.
2.Wearing method problem.
3.The patient is in movement. 

1.Correctly connect.
2.With correct wearing 

method.
3.The patient shall keep 

calm.

Powering on disabled 1.Battery capacity lack or no 
power.

2.Device failure.

1.Charge the battery at 
once.

2.Contact your local ser-
vice center

PC can not identify SD 
card disk symbol.

1.The USB connection has 
been worn and in bad con-
nection.

2.SD card is damaged.

1.Try to connect the USB 
data line repeatedly.

2.Contact your local ser-
vice center.

In full power,the opera-
tion time is too short or 
the charging time is al-
ready over 10 hours, the 
battery is still not full.

The battery is damaged. Contact your local service 
center

State Alarm condition delay Alarm signal generation delay

Low voltage alarm 1s 20ms

SpO2 alarm 330ms 20ms

Pulse rate alarm 330ms 20ms

Probe error alarm 16ms 20ms
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Appendix 2
Guidance and manufacturer’s declaration – electromagnetic emissions – for 
all EQUIPMENT and SYSTEMS 

Guidance and manufacturer’s declaration – electromagnetic immunity – for 
all EQUIPMENT and SYSTEMS

ENGLISH

Guidance and manufacturer’s declaration – electromagnetic emission

The RS01 is intended for use in the electromagnetic environment specified below. The 
customer of the user of the RS01 should assure that it is used in such and environment.
Emission test Compliance Electromagnetic environment – guidance

RF emissions
CISPR 11

Group 1 The RS01 uses RF energy only for its internal 
function. Therefore, its RF emissions are very 
low and are not likely to cause any interference in 
nearby electronic equipment.

RF emissions
CISPR 11

Class B The RS01 is suitable for use in all establishments 
other than domestic and those directly connected 
to a low voltage power supply network which sup-
plies buildings used for domestic purposes.

Guidance and manufacturer’s declaration – electromagnetic immunity

The RS01 is intended for use in the electromagnetic environment specified below. The 
customer or the user of RS01 should assure that it is used in such an environment.
Immunity test IEC 60601 

test level
Compliance
level

Electromagnetic 
environment – guidance

Electrostatic 
discharge (ESD)
IEC 61000-4-2

±6 kV contact
±8 kV air

±6 kV contact
±8 kV air

Floors should be wood, concrete 
or ceramic tile. If floor are cov-
ered with synthetic material, the 
relative humidity should be at 
least 30%.

Power frequency 
(50/60Hz) 
magnetic field
IEC 61000-4-8

3A/m Class B Mains power quality should be 
that of a typical commercial or 
hospital environment.
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Guidance and manufacturer’s declaration – electromagnetic immunity – for 
EQUIPMENT and SYSTEMS that are not LIFE-SUPPORTING

80 MHz - 800 MHz

800 MHz - 2,5 GHz

d = [       ] √ P
3.5
E1

d = [       ] √ P
7

E1

d = [       ] √ P
3.5
V1
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Guidance and manufacturer’s declaration – electromagnetic immunity

The RS01 is intended for use in the electromagnetic environment specified below. The 
customer or the user of RS01 should assure that it is used in such an environment.
Immunity test IEC 60601 

test level
Compliance
level

Electromagnetic 
environment – guidance

Conducted RF
IEC 61000-4-6

Radiated RF
IEC 61000-4-3

3 Vrms
150 kHz 
to 80 MHz

3 V/m
80 MHz to 
2.5 GHz

3 Vrms

3 V/m

Portable and mobile RF communica-
tions equipment should be used no 
closer to any part of the RS01, includ-
ing cables, than the recommended 
separation distance calculated from 
the equation applicable to the fre-
quency of the transmitter.

Recommended separation distance

Where P is the maximum output pow-
er rating of the transmitter in watts (W) 
according to the transmitter manufac-
turer and d is the recommended sep-
aration distance in metres (m).
Field strengths from fixed RF trans-
mitters, as determined by an electro-
magnetic site survey,a should be less 
than the compliance level in each fre-
quency range.b

Interference may occur in the vicinity 
of equipment marked with the follow-
ing symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 
affected by absorption and reflection from structures, objects and people.
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a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) 
telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broad-
cast cannot be predicted theoretically with accuracy. To assess the electromagnetic environ-
ment due to fixed RF transmitters, an electromagnetic site survey should be considered. If 
the measured field strength in the location in which the RS01 is used exceeds the applicable 
RF compliance level above, the RS01 should be observed to verify normal operation. If ab-
normal performance is observed, additional measures may be necessary, such as reorienting 
or relocating the RS01.
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than  3 V/m.

Recommended separation distances between portable and mobile RF commu-
nications equipment and the RS01

The RS01 is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of the RS01 can help prevent 
electromagnetic interference by maintaining a minimum distance between portable 
and mobile RF communications equipment (transmitters) and the RS01 as recom-
mended below, according to the maximum output power of the communications 
equipment.

Rated maximum 
output power of 
transmitter
(W)

Separation distance according to frequency of transmitter 
(m)

150KHz to 80MHz 80MHz to 800MHz 800MHz to 2.5GHz 

0.01 0.12 0.12 0.23

0.1 0.37 0.37 0.74

1 1.17 1.17 2.33

10 3.69 3.69 7.38

100 11.67 11.67 23.33

For transmitters rated at a maximum output power not listed above, the recommended sep-
aration distance d in metres (m) can be estimated using the equation applicable to the fre-
quency of the transmitter, where P is the maximum output power rating of the transmitter in 
watts (W) according to the transmitter manufacturer.
NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range 
applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 
affected by absorption and reflection from structures, objects and people.

Recommended separation distances between portable and mobile RF com-
munications equipment and the EQUIPMENT or SYSTEM – for EQUIPMENT 
or SYSTEM that are not LIFE-SUPPORTING

d = [       ] √ P
3.5
E1

d = [       ] √ P
7

E1
d = [       ] √ P

3.5
V1
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Disposal: The product must not be disposed of along with other  do-
mestic waste. The users must dispose of this equipment by bringing it to 
a specific recycling point for electric and electronic equipment. For fur-
ther information on recycling points contact the local authorities, the local 
recycling center or the shop where  the product was purchased. If the 
equipment is not disposed of correctly, fines or penalties may be applied 
in accordance with the national legislation and regulations.

GIMA WARRANTY CONDITIONS
Congratulations for purchasing a GIMA product. This product meets high qualita-
tive standards both as regards the material and the production. 
The warranty is valid for 12 months from the date of supply of GIMA.
During the period of validity of the warranty, GIMA will repair and/or replace free 
of charge all the defected parts due to production reasons. 
Labor costs and personnel traveling expenses and packaging not included.
All components subject to wear are not included in the warranty.
The repair or replacement performed during the warranty period shall not extend 
the warranty. The warranty is void in the following cases: repairs performed by 
unauthorized personnel or with non-original spare parts, defects caused by neg-
ligence or incorrect use. GIMA cannot be held responsible for malfunctioning on 
electronic devices or software due to outside agents such as: voltage changes, 
electro-magnetic fields, radio interferences, etc. 
The warranty is void if the above regulations are not observed and if the serial 
code (if available) has been removed, cancelled or changed.
The defected products must be returned only to the dealer the product was pur-
chased from. Products sent to GIMA will be rejected.


